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Profile of Ag Law Section 
Council Member: Cari Rincker

Background and introduction
Full Name: Cari Rincker 
Hometown or Current Residence: 

Shelbyville, IL for both! 
Law School Attended and Year of 

Graduation: Pace University 2007 
(transferred from Regent University, 
School of Law)

Year Admitted to the Illinois Bar: First 
admitted in 2007 (New Jersey); admitted to 
the Illinois Bar in 2015

Current Role or Status (e.g., practicing 

attorney, judge, retired): Attorney in private 
practice; principal of Rincker Law, PLLC

Brief overview of your current or 

most recent practice: Rincker Law is a 
practice focusing on Food, Farm and 
Family. We help multi-generational 
family farms focus on business planning, 
estate planning and estate planning while 
navigating family changes—marriage 
(prenups!), divorce and death (i.e., 
probate and trust administration). We 
also help the agriculture sector with 
intellectual property and real estate 
matters. 

BY SARA PESKA & EAN ALBERS
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Speaker Carolyn Elefant (left) presented “Artificial Intelligence – A 
Primer for Illinois Practitioners” at the 32nd Annual Agricultural Law 
Seminar. Carolyn is pictured with Sponsor/Moderator Cari B. Rincker.

Ag Law Seminar Sponsor/Moderator Cari B. Rincker with Coordinator/
Moderator Andrew G. White. A big thank you to Andrew for planning 
this successful Seminar!
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Career path and practice
What inspired you to pursue a legal 

career, particularly in a rural setting?
I was an intern on Capital Hill through 

the Texas A & M University, College of 
Agriculture and Life Science’s agriculture 
policy program. I originally went to 
law school because I was interested in 
agriculture policy. 

After spending a decade in New York 
City, it was ultimately family that brought 
me back home to a rural community. My 
desire to start a family and then later after 
my children were born to live where I 
could have more family support. 

I spent a decade worried about the 
change of running my law practice from 
a metropolitan area to a small town—my 
only regret is not doing it sooner!

What areas of law have you focused 
on throughout your career?

Early on in my career, I did Door Law. 
I took what came in through the Door. 
And eventually my first divorce came my 
way. There is a saying that lawyers don’t 
find their law practice, their practice finds 
them. That is how I feel about my family 
law practice. In a sense, family law is a 
calling insofar that we are helping families 
navigate these difficult transitions. 

Presently, my family law practice is 
more geared towards high net worth farm 
divorces and mediation. I particularly 
enjoy helping farm families navigate the 
divorce and separation because divorce 
is one of the Big D’s that can destroy a 
family farm—but with the right care 
and attention, it can be preserved for 
succession throughout the process. 

I grew up on a multi-generational 
family farm. Working in the area of food 
and agriculture law has always been 
in my wheelhouse. Specifically, I have 
counseled farmers, agri-businesses and 
food entrepreneurs on starting, growing, 
merging or ending their businesses. A 
goal that I have for 2026 is to develop 
a fractional General Counsel program 
for farms and agri-businesses on a 

subscription basis. 

Did you always intend to practice in a 
rural area? Why or why not?

No, I did not. For a while, I ran from 
it into the Borough of Manhattan in 
New York where the population of my 
hometown fit into a few city blocks. But 
my country heart yearned for some space, 
freedom and fresh air again. Although I 
love going back to NYC, I haven’t regretted 
my decision to move home for one minute. 
It has been a welcomed change of pace. 

Describe your typical client base and 
the community you serve.

I have had some challenges as my 
food and agriculture law practice is more 
national while my family law practice is 
more local. This dichotomy is challenging 
from a business standpoint, especially 
as my law practice grows to be more 
concentrated with agriculture law. 

What did you enjoy most about your 
legal career?

It’s the hard that makes it good, right? I 
do not love the battle of litigation or the war 
rooms before trial but some of my biggest 
accomplishments were fighting my way 
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through 2, 3, 5, 7 day trials throughout my 
career. One case in particular was rewarding 
to me as my client was being alienated from 
the other parent and he is now the sole 
custodial parent—this trial was particularly 
memorable because my son was 5 months 
old making the long nights before each day 
of trial more difficult. 

What aspects of the practice were 
most challenging or frustrating?

Moving from a larger metropolitan 
community to another smaller community 
can always be difficult, especially if you 
are used to doing things in a different way. 
Learning the new culture and procedures 
are always a challenge. 

Was there anything you actively 
worked to change or improve in the legal 
system or in your practice environment?

I tried to work on some new case 
management orders, similar to another 
county in Illinois, along with a small group 
of attorneys. Change is hard when certain 
county bars are used to certain procedures. 
I have also been an advocate for financial 
mediation on family law matters believing 
that courts should maintain a roster of 
mediators who are able to mediate child 
support, spousal maintenance, and the 
division of assets/debt in a divorce. 

How has rural legal practice changed 
over the course of your career?

The most notable change is Zoom 
court/remote hearings that have been 
available post pandemic that has made it 
easier to practice in multiple counties. 

Accomplishments and 
contributions

What professional accomplishments 
are you most proud of?

Early in my career, my Food & 
Agriculture Law Blog made the Top 
100 Blawg list. I won the Excellence in 
Agriculture Law (Private Practice) from 
the American Agriculture Law Association 
(AALA) and the Early Career Award from 
Texas A & M University. 

Have you been involved in 
community service, local organizations, 
or bar association work? Please describe.

I serve on the board of directors for 

a not-for-profit trying to raise monies 
to build a daycare in my hometown. I 
volunteer as general counsel to a junior 
college foundation board. I am also the 
editor of the newsletter for the ISBA 
Agriculture Section Council.

Are there any cases, projects, or 
experiences that stand out as especially 
meaningful or impactful?

I was a graduation commencement 
speaker at Lake Land College, circa 2019. 
It was surreal being at my alma mater 
speaking to over 2,000 graduates and 
families. I am a big believer in the junior 
college educational system. 

Looking ahead
What advice would you give to young 

attorneys considering rural practice?
In 2025, technology allows for virtual 

staff and offices. I have remote employees 
and independent contractors in numerous 
positions. 

Don’t be afraid of AI. Instead of hiding 
from it, learn to embrace it. It’s here to stay. 

What opportunities do you think exist 
today in rural law practice that didn’t 
exist earlier in your career?

Virtual mediation! Mediators can help 
facilitate conversations with litigants from 
the comforts of their own locations. This 
is something that was rarely done early 
pre-pandemic. This should be embraced by 

mediators, rural practitioners and litigants 
alike. 

Are there services, programs, or 
initiatives you’d like to see the Illinois 
State Bar Association expand or 
implement?

Yes, I would love to see more CLE 
programs that are more step-by-building-
step. The family law section did an 
excellent How To Series on a myriad 
of family law topics and this would be 
welcomed in different practice areas such 
as estate planning, real estate, trademarks, 
business planning, bankruptcy, etc. 

Anything else you’d like to share 
with your peers or the broader legal 
community?

Like any organization, the ISBA has 
come alive for me now that I have joined 
two Section Councils. Anything you 
can do to help get involved would only 
strengthen this Section Council and your 
individual experience with ISBA. Please 
consider contributing to the newsletter or 
get involved in a committee. n

Sara, an attorney with Mahoney & Mahoney, 
LLC, serves as the general practice branch of 
the firm as well as supports the large litigation 
practice of Mahoney & Mahoney.

Ean R. Albers is an associate attorney 
with Hasselberg Grebe Snodgrass Urban & 
Wentworth, located in Peoria and Lacon, 
Illinois. 

SHOULDN’T YOU BE AN IBJ AUTHOR? 
Write for the Illinois Bar Journal and...

• ESTABLISH YOURSELF AS A SUBJECT MATTER EXPERT.

• EARN FREE CLE CREDIT! (SEE RULE 795 (d)(7).)

• RECEIVE A FREE COMMERCIAL-PRINT GRADE PDF OF 
YOUR ARTICLE. 

ISBA.ORG/IBJ/MANUSCRIPTGUIDE
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Introduction
Historically, an owner of real estate, in 

fee simple absolute, was thought to own 
a pie shaped cubit, extending from the 
center of the Earth, all the way up to the 
heavens. This traditional rule of ownership 
is a gross over simplification which, as we 
shall see, does not truly apply in the case of 
oil and gas. 

Oil and gas are the residue of ancient 
animal or vegetable deposits, which have 
been compressed under the surface of the 
Earth by tremendous geological forces for 
eons. Although they may not be minerals 
in the scientific sense, they are considered 
to be minerals, for legal purposes. Gillette 
v. Chicago, Wilmington and Franklin Coal 
Company, 382 Ill. 241 (1943). 

The word “minerals” in the phrase 
“including coal and other minerals,” 
has been held to include oil and gas, as 
a matter of law. Nance v. Donk Brothers 
Coal & Coke Co., 13 Ill. 2d 399 (1958). The 
legal definition of the term “minerals” is 
rather broad. It is akin to what most would 
consider natural resources which are 
found underground and may be mined or 
produced.

The important point for our purposes 
here is that oil and gas share a unique 
attribute which distinguishes them from 
all other minerals, namely, they are 
fugacious. Unlike hard minerals such as 
coal or limestone, they do not remain 
static. Instead, oil and gas migrate in 
response to changes in the surrounding 
geological conditions. Oil and gas do 
not naturally or continuously flow, like 
water in underground streams. Rather, 
they’re trapped in rock, sand or limestone 
formations, underneath the surface of 
the Earth, where they are subject to near 
constant geological pressures that hold 
them fixed in place. 

While the natural conditions remain 

undisturbed, oil and gas generally remain 
static. However, oil and gas may migrate 
in response to either naturally occurring 
or artificial changes in the surrounding 
geological conditions. For example, once a 
pressurized oil or gas bearing formation is 
penetrated by the drilling of a well, oil and 
gas begin moving towards the well bore, 
being the point of least resistance. It is 
this fugacious quality of oil and gas which 
distinguishes them from all other minerals. 
Moreover, it is this unique characteristic 
which is largely responsible for shaping the 
law of oil and gas as we know it today.

Ownership 
Since we have only limited information 

concerning the geological landscape 
thousands of feet below the surface and 
since oil and gas may migrate during 
the course of production, it is difficult 
to say, with any degree of certainty, 
where a specific quantity of oil and 
gas that has been produced may have 
originated. Depending upon the geological 
circumstances involved, oil produced 
from a given well bore may have migrated 
or drained from underneath adjoining 
acreage. The two questions thus posed 
were who “owns” the oil and gas, 1) while 
it remains in place and perhaps more 
importantly, 2) once it is produced.

Courts in various jurisdictions have 
grappled with the issue, resulting in 
two different theoretical approaches. 
Historically, oil and gas were likened 
to wild animals and or riparian waters. 
Due to their fugacious nature, they were 
referred to as minerals ferae naturae. 
As such, they were not owned by 
anyone, while they remained in their 
natural state, but could only become 
subject to ownership when reduced to 
actual possession or “capture.” This is 
an intriguing, if not accurate premise, 
antiquated by science and technology, 
remains partially in effect.

A point bearing emphasis is that the 

practical difficulty of identifying where 
oil and gas originated, has resulted in 
an ownership theory, which is unlike 
any other substance, known to the law. 
Although the “rule of capture” remains 
the law in virtually all jurisdictions where 
oil and gas is produced, the ownership 
theory of oil and gas in place, varies by 
jurisdiction. Some states recognize the 
“ownership theory,” some accept the 
“non-ownership theory.” The analogy 
to wild animals or riparian waters has 
been abandoned, mainly because oil and 
gas generally only migrate in response 
to some artificial disruption of natural 
forces occasioned by man. Observation 
has revealed that they do not simply flow, 
naturally like water in an underground 
stream, or wander of their own accord like 
wild animals.

A better understanding of the nature 
and properties of oil and gas, has caused the 
law to evolve accordingly. The differences in 
ownership theory of oil and gas in place is 
interesting, but perhaps less important than 
the rule of ownership once it is captured, 
produced, sold and realized into monetary 
gain. That after all is the primary objective 
of most owners and developers.

Oil and gas in place: Ownership 
vs. exclusive rights

In some states, the owner of the real 
estate is said to “own” the oil and gas 
underneath the surface. This theory is 
referred to as the “ownership in place 
theory.” This, however, does not mean that 
one may prevent others from undertaking 
production activities, on their own land, 
which may cause the oil or gas to migrate, 
because, while it remains underground, 
oil and gas remain subject to the rule of 
capture.

In other states, such as Illinois, the 
landowner does not “own” the oil and gas 
in place underneath his or her property 
in a conventional sense. Rather he or she 
owns the “exclusive right” to use his or 

Oil and Gas Law Ownership Rights and 
Surface Issues
BY DAVID M. FOREMAN
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her land to explore for and produce it. 
The owner of the mineral rights has been 
held to own the exclusive right to prospect 
for oil and gas by drilling a well on the 
property. Illinois is therefore categorized 
as what is commonly referred to as an 
“exclusive rights” or “non-ownership 
theory” state. See Williams & Meyers, Oil 
and Gas Law, Sections 203, 203.1.

Under Illinois Law, oil and gas under 
the ground are not capable of ownership 
separate and distinct from the real estate. 
Murgarger v. Franklin, 18 Ill. 2d 344, 163 
N.E.2d 818 (1960). Due to its fugacious 
nature, it’s been said that there can be 
no such thing as absolute title to oil and 
gas in place, underground. Reed v. Texas 
Company, 22 Ill. App. 2d 131, (1959); Poe 
v. Ulrey, 233 Ill. 56; Updike v. Smith, 378 Ill. 
600 (1942); Trigger v. Carter Oil Co., 372 
Ill. 182 (1939).

An owner of oil and gas rights owns 
merely the exclusive right to prospect and 
attempt to produce it. Pickens v. Adams, 7 
Ill. 2d 283, 131 N.E.2d 38 (1956). Although 
one may not own the oil or gas in place, 
they have a legally protectable right to 
explore for it and may prevent and recover 
for an invasion of that right as a trespass 
and/or conversion.

The rule of capture
The difference in ownership theory is 

largely academic as “the rule of capture” 
applies in either case. Operation of the 
rule leads to essentially the same result 
by means of a slightly different legal path, 
notwithstanding the ownership theory 
involved. It also defines the correlative 
rights of the parties to produce from a 
common reservoir.

According to the rule of capture, the 
person who owns the mineral rights of 
land where the well bore is located, also 
owns any oil or gas produced therefrom, 
regardless of where it may have originated. 
Oil and gas become personalty capable 
of ownership, separate and distinct from 
the land upon severance from the realty 
(i.e., the moment it is captured and enters 
the well bore). Until that moment, oil and 
gas remains subject to capture by other 
producers that have a well bore which 
penetrates into the same oil bearing 

formation or reservoir. Until oil or gas is 
actually produced, severed from the real 
estate and reduced to physical possession, 
each remains subject to capture, by anyone 
legally producing from the common 
source or supply. Trigger v. Carter Oil 
Co., 372 Ill. 182 (1939) and Continental 
Resources of Illinois v. Illinois Methane LLC, 
364 Ill. App. 3d 361 (5th Dist. 2006).

The rule of capture is not only a rule 
of necessity, it is very pragmatic as well. 
It rewards the risk borne by the parties 
who drilled the well(s). If they had to 
share the bounty of their efforts with 
their neighbors, because some of the oil 
and gas being produced is draining from 
beneath adjoining land, they would be less 
inclined to make the investment required 
to prospect for, discover and produce oil 
and gas. The rule of capture provides a 
very simplistic, yet economically efficient 
result. It correlates risk with reward. It 
balances the correlative rights of parties to 
exploit a common supply of reservoir, with 
the entrepreneurial initiative that must be 
undertaken to do so. Simply put, “finders 
keepers, losers weepers.” 

As a consequence of the Rule of Capture, 
a landowner has no cause of action for 
drainage caused by a neighboring well. The 
oil produced becomes the property of the 
person who captured it through a lawful 
well, bottomed on his or her land, regardless 
of the fact that the oil may have migrated 
from beneath neighboring property. The 
neighbor’s remedy to prevent drainage and/
or displacement is, to go and do likewise, 
also known as “first come, first serve.”

These two rules create competition, 
promote recovery and reward initiative, 
but are not without draw backs. This sort 
of “every man for himself ” philosophy, 
may in fact over promote drilling, which 
could in turn, lead to a rapid decline in 
reservoir pressure and ultimately less 
production from the formation than would 
be realized in a more gradual, controlled 
development program. That, however, is an 
issue for the Illinois Department of Natural 
Resources, Office of Oil and Gas Resource 
Management, One Natural Resources 
Way, Springfield, Illinois 62702-1271. 
Reservoir optimization and management 
is controlled by well spacing and density 

regulations. Operation of Pool Wide Units, 
Waterflooding, Unitization, and other 
agency rules authorized by the Illinois Oil 
and Gas Act, 225 ILCS 725/1 et seq. may be 
found in 62 Ill. Admin Code, Part 240.10 et 
seq. Having discussed the nature of oil and 
gas ownership, we now turn to another 
unusual aspect of mineral rights.

Severance of mineral rights
Ownership of real estate has been 

likened to a bundle of twigs. The bundle 
is comprised of an almost infinite number 
of rights or uses. Ownership of the various 
minerals, are twigs included in the bundle. 
Any one of them may be severed, split 
off, removed from the bundle and owned 
separate and apart from the others.

There are essentially two ways of 
severing mineral rights from the surface 
or other rights. One is by reservation, 
wherein the Grantor conveys the real 
estate, but reserves all or a portion of the 
minerals. The second is by express grant, 
where the owner of the real estate expressly 
conveys the mineral rights to a third party.

Much confusion has resulted from 
deeds which “except” all or a portion of 
the minerals rather than reserving them or 
making the conveyance “subject to” prior 
reservations or grants. It may be unclear 
whether an exception refers to a current 
reservation or a prior grant. This confusion 
is compounded by the fact that title 
insurance policies typically do not cover 
minerals. 

Although Illinois case law recognizes 
“exceptions” to the granting clause of an 
instrument, it is better practice to avoid 
use of the term “except” when drafting a 
mineral conveyance. Instead, expressly 
refer to the mineral rights as being either 
prior or current grants or reservations. 

Mineral rights can not only be severed 
from the surface, they can also be divided 
up several different ways. They may be 
divided into terms, by time, or divided 
three dimensionally, by formation. The 
ability to slice and dice mineral ownership 
by time or space can result in a number of 
possibilities that can make determining title 
very challenging. Each case must be judged 
on its own particular facts. Each chain of 
title must be examined. Further, a host of 
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legal rules regarding the construction of 
instruments and conveyance, intended to 
resolve ambiguities, may actually lead to 
results which are contrary to the parties’ 
subjective intent.

Minerals are conveyed unless reserved 
or excepted. In a warranty deed, the 
Grantor warrants title to the real estate 
including the minerals, unless the minerals 
have specifically been made the subject 
of an exception or reservation. Updike v. 
Smith, 878 Ill. 600 (1942). 

The act of splitting the minerals 
from the other land rights is referred to 
as “severance.” Whenever minerals are 
severed from the surface, two distinct 
estates come into being: The mineral estate 
and the surface estate. These two separate 
estates may be conveyed and subdivided as 
other interest and real estate. Shell Oil Co. 
v. Moore, 382 Ill. 556 (1943). 

Implied easement in favor of 
mineral estate

A mineral estate is a freehold estate 
under Illinois law. As such, the owner of it 
is entitled to all the usual remedies at law 
and in equity for protection of the rights 
and incidents of ownership of real estate. 
Pickens v. Adams, 7 Ill. 2d 283 (1956).

As stated above, due to their fugacious 
character, oil and gas are incapable of 
separate distinct ownership from the land, 
until they are actually found and produced. 
A deed to minerals carries not only title to 
solid minerals, but also what is necessary 
to acquire title to or possession of the 
fugacious minerals, meaning the right 
to enter upon the surface to explore and 
if found, to reduce them to possession. 
Pickens v. Adams, 7 Ill. 2d 283 (1956). 

The important point for our purposes 
here is that a severed oil and gas interest 
carries with it an implied right to use 
so much of the surface as is reasonably 
necessary to enjoy the mineral estate. The 
law implies a right to use the surface, to 
access the minerals, in much the same way 
the law implies an easement over retained 
land, adjacent to a public road in the grant 
or deed of conveyed land, in order to 
allow access as the tract conveyed would 
otherwise be land locked. In the case of 
minerals, the access is three dimensional 

and is both horizontal and vertical.
The mineral estate is the “dominant 

estate” and the surface estate is the “servient 
estate.” The servient estate bears a burden 
of use, in favor of the dominant estate. It 
is necessary for the owner of the severed 
mineral estate to use some of the surface, in 
order to benefit from, or enjoy the mineral 
estate. For example, a certain amount of 
surface is necessary to build roads, drill 
wells, and if successful, lay flow lines, 
electric lines, and erect storage tanks, etc. 

The implied right is one of reasonable 
use. It extends to both primary and 
secondary recovery. It is not unlimited. 
What is reasonable, depends upon the 
circumstances. It is submitted that a use 
would not be permitted, if it unreasonably 
interfered with a large majority of the 
landowner’s primary use and enjoyment of 
the surface.

Surface owner’s rights
When there has been no severance of 

the minerals from the surface, there is little 
dispute as to the parties’ surface rights. The 
lease agreement itself contains provisions 
and covenants which address these uses. 
However, where the minerals have been 
severed from the surface, the surface owner 
often times finds him or herself subject to 
the uses of which they were unaware, that 
can negatively impact their current and 
future use of the surface. Since most title 
insurance policies don’t cover minerals, 
surface owners may not appreciate the 
significance of the severance or the implied 
easement which arises therefrom.

In these cases, the surface owners have 
to put up with all of the adverse effects 
associated with oil and gas operations, 
but enjoy none of the resulting benefits. 
This often leads to acrimony and is fertile 
ground for litigation, dispute, and in some 
cases vandalism or interference with 
production. 

In most cases, the surface owner 
unwittingly finds themselves holding what 
they perceive to be the short end of the 
stick, not realizing that it was removed 
from the bundle of rights, before they 
purchased it. Not being aware of the pre-
existing legal situation, it seems unfair. 
Surface owners often become angry or 

upset, when the operator commences new 
activities and they discover that they are 
not “in on the deal.”

This friction between surface owners 
and mineral owners/developers was the 
primary impetus behind the Drilling 
Operations Act, 765 ILCS 530/0.01 et seq. 
which is discussed below.

The Drilling Operations Act
In an effort to assuage the surface 

owners, the legislature first passed and 
later amended the Drilling Operations Act, 
to require operators who drill new wells, 
to notify and meet with surface owners to 
discuss certain issues such as the location 
of roads etc. in an attempt to work out a 
mutually agreeable solution before new 
wells are drilled. Failing that, there are 
provisions for calculating damages, and 
tendering payment. 

The Drilling Operations Act is a 
significant departure from prior common 
law, in one important respect, namely 
that it purports to make the operator 
continually liable for land taken out of 
production by reason of any new drilling 
operations. This obligation could be 
substantial. Therefore, it is necessary to 
understand when the Act applies and 
when it does not.

The Drilling Operations Act only applies 
to the drilling of new wells. It does not apply 
to re-working operations. 765 ILCS 530/3. 
Moreover, the Act only applies when the 
surface owner has not consented in writing 
to the drilling operations and: a) there has 
been a complete severance of the ownership 
of the oil and gas from the ownership of 
surface or b) where the surface owner also 
owns an interest in oil and gas which is 
the subject of either 1) an administrative 
integration proceeding brought pursuant 
to 225 ILCS 725/1 et. seq., 62 Ill. Admin 
Code 240.132 or 2) a proceeding brought 
pursuant to the Oil and Gas Rights Act, 765 
ILCS 520/0.01 et. seq.

If the surface owner executes an 
Agreement or a Release, then the Act does 
not apply. Any such document should 
be clear on its face, that the landowner 
is accepting a lump-sum payment in 
full satisfaction of all current and future 
damages, including the right to all future 
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compensation for the land being taken out 
of production. This presents an interesting, 
but unresolved question as to the effect 
on future owners, specifically, whether the 
current owner can waive a successor’s right 
to future compensation, for land taken out 
of production by reason of the new drilling 
operations. Based on how waivers of 
subsidence rights in coal deeds have been, 
I would submit, the answer is affirmative. 
Time will surely tell. In the meantime, 
it is advisable to obtain a written release 
whenever possible.

Another similar, but unanswered 
question is likewise presented, when the 
surface was severed from the minerals 
after the property was leased. In my 
opinion, the property was subject to the 
lease when the severance occurred and the 
Drilling Operations Act does not apply 
to these situations. The lease (i.e., written 
agreement) was made with the person(s) 
who owned the surface at the time. The 
lease thus constitutes an “agreement in 
writing” to the drilling operations, and 
it includes an express easement for the 
right to use the surface. The grant of that 
easement is in the chain of title and all 
subsequent conveyances are on notice of 
and subject to it.

 To my knowledge, this issue has not yet 
been litigated in this State. Parties should 
recognize that political and public opinion 
appears to be shifting towards surface 
owners and it would be naive to think that 
such forces could not influence a Court’s 
decision in the event of a dispute.

There is also a question as to the 
validity of the statute’s requirement that 
the operator compensate the surface owner 
for the loss of value of commercial crop 
corresponding to the lands taken out of 
production, because of the use thereof 
by the operator for roads and production 
equipment. Said provision requires the 
operator to pay for the exercise of a right 
which it already possesses. 

If the minerals were severed first, then 
the surface owner acquired the property, 
subject to that severance and the implied 
easement arising from it. The right to use 
as much of the surface as is reasonably 
necessary was acquired along with the 
mineral rights from the original owner and 
the original owner of those rights was paid 

consideration and compensation for them. 
Both the Illinois and Federal 

Constitution prohibit taking of property 
without due process of law. The statute, 
which was largely a compromise, requires 
the operator proposing to drill a new well 
to pay additional damages, each year, for 
the value of the crop that could have been 
raised on the land which is taken out of 
production, in order to exercise a right 
which already exists. This issue also has 
not been decided by any Appellate Court 
in Illinois and may likely not be, given the 
cost of litigation and appeals, relative to the 
damages involved. 

Lastly, for those that have attempted 
to comply with the Act in the absence 
of an agreement with the surface owner, 
there are some questions concerning the 
procedure for appraising and tendering 
payment for damages. The Act has a 
method and a formula for calculating 
damages.

Compaction
The Drilling Operations Act does not 

make any reference to “compaction” or 
alleged damages resulting from same in 
subsequent years. Rather, the Act divides 
surface damages and the operator’s duties 
into 3 categories according to project 
completion:

1. Drilling Operations—duty to pay 
reasonable damages to growing crops, etc.

2. Production Operations—duty to pay 
reasonable damages to growing crops, etc.

3. Post Cessation, Plugging and 
Abandonment Operations—duty to restore 
the surface.

The initial tender for drilling operations 
should include damages to “growing crops, 
trees, shrubs, fences, roads, structures, 
improvements, personal property and 
livestock thereon,” resultant from drilling. 
See 765 ILCS 5/6(A)(1).

Only in the event drilling is successful, 
the well is completed and “put on pump” is 
the surface owner entitled to compensation 
for “the loss of value of a commercial 
crop corresponding to lands taken out of 
production because of the use thereof by 
the operator for roads and production 
equipment.” See 765 ILCS 530/6(A)(3).

If the well was a “dry hole”, then the 
only concern is with damages under 

section A(1) (i.e., crop damages) and the 
duty to restore the surface to a condition 
“as near as practicable” to the condition 
of the surface prior to commencement of 
drilling operations.

The statutory formula for calculating 
crop damages also applies to subsequent 
activities. However, the Act does not 
give rise to a claim for compaction or 
“diminished productive capacity” in 
subsequent years for the initial entry 
and use of the surface during drilling 
operations, absent proof of the operator’s 
negligence. See 765 ILCS 530/6(A)(4).

Summary
In summary, The Drilling Operations 

Act was well intended to provide guidance 
and diffuse what could be an incendiary 
situation, but in practice, can provide 
more questions than answers. The unique 
nature of ownership rights and the ability 
to sever minerals from the surface results 
in conflicts which the law must balance. 
Although the rules have remained much 
the same for many years, the technology 
and circumstances to which they are 
applied are ever changing. No doubt, the 
law of oil and gas will evolve accordingly to 
meet those challenges. n

David M. Foreman is an attorney with Foreman 
& Kessler Ltd, located in Salem, Illinois. 

This article was originally published in Mineral 
Law (December 2025, Vol. 52, No. 2), the 
newsletter of ISBA’s Section on Mineral Law.
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MANAGING EMAIL CAN BE 

OVERWHELMING, especially when you’re 
juggling multiple tasks or handling a high 
volume of messages. Fortunately, Microsoft 
Outlook offers several powerful features 
to help streamline your workflow, improve 
productivity, and ensure you never miss an 
important task or email. Here are my top 
five email management tips for Outlook to 
help you stay organized and efficient.

1) Leverage Quick Parts for 
Repetitive Email Responses

If you find yourself sending similar 
responses or messages regularly, Outlook’s 
Quick Parts feature is a real game-changer. 
This tool allows you to save text snippets—
like responses to frequently asked 
questions, meeting invitations, or standard 
replies—so you can insert them into an 
email with just a few clicks.

To use Quick Parts:
•	 To save a new Quick Part:

•	 Compose a new email (Click 
New Email in the Ribbon) and 
type the text you want to save.

•	 Highlight the text you just typed 
and go to the Insert tab.

•	 Click on Quick Parts, then select 
Save Selection to Quick Part 
Gallery.

•	 Give your Quick Part a name and 
hit OK.

•	 To use a new Quick Part:
•	 Compose a new email (Click 

New Email in the Ribbon).
•	 Make sure your curser is in the 

body section of the email. 
•	 Click on the Insert tab and select 

the saved snippet. 
•	 OR—you can type the first 4 or 

more characters of the name of 
the Quick Part, and you can press 
Enter or Tab to have the remain-
der of the Quick Part auto-fill.

This can significantly speed up your 
email responses and ensure consistency 
in your communication. I frequently use 
this feature when communicating with 
potential clients or with my administrative 
contractors where the information I am 
communicating is exactly the same. No 
need to continually re-type the same 
message over and over again. 

NOTE: Quick Parts are not available on 
Outlook for Mac or Outlook on the web.

2) Streamline Workflows with 
Quick Steps

Outlook’s Quick Steps feature allows you 
to automate repetitive tasks that require 
multiple steps. Whether it’s moving emails 
to a specific folder, forwarding a message, 
or creating a new task, Quick Steps can 
save you time by consolidating several 
actions into one click.

To set up Quick Steps:
•	 Navigate to the Home tab and look 

for the Quick Steps section.
•	 Click on Create New to define your 

custom action.
•	 Give your Quick Step a name you 

will remember and then choose 
what you want to happen. You can 
choose from predefined actions 
like Move to Folder, New Meeting, 
or Reply & Delete, or create a 
combination of actions.

Once you’ve set up Quick Steps, you 
can apply them to emails with a single 
click, helping you stay on top of your inbox 
and boosting your efficiency. Remember 
that you will want to only use this when 
the steps are always the same—emails 
forwarded to the same person and then 
filed in the same folder—each time. I 
would recommend only having around 
6 Quick Steps because any more than 
that, you spend more time looking for 
the appropriate Quick Step than just 
performing the steps yourself in Outlook.

NOTE: Quick Steps are not available on 
Outlook for Mac or Outlook on the web.

3) Organize Your Inbox with 
Folders and Categories

While Outlook’s search functionality 
is excellent, it’s always beneficial to have 
a clear organizational system in place. 
Using Folders and Categories can help you 
manage your emails and keep your inbox 
clutter-free.

Folders allow you to sort emails into 
specific categories or files. I maintain a 
folder/sub-folder structure that breaks 
saved emails down to Administrative, 
Client Matters, and Closed Client Matters. 
Under each of these 3 folders, I maintain 
subfolders for each type of administrative 
matter or each client or closed client. To 
create a folder:

•	 Right-click on your inbox or another 
folder in the folder pane.

•	 Select New Folder, then give it a 
name and hit Enter.

With a solid folder and category 
system in place, you can quickly find the 
information you need and keep your inbox 
from becoming overwhelming.

You can also use Outlook’s search 
function to search by folder or your entire 
mailbox. This is very helpful when you 
accidentally drag and drop an email into 
the wrong folder. If you use the search 
bar at the top of Outlook, you can use the 
dropdown menu immediately to that box’s 
left to search the specific folder you are in or 
you can use it to search Current Mailbox or 
All Outlook Items. Most often, if I cannot 
remember where I saved an email, I will use 
Current Mailbox to search all folders in my 
mailbox to find the email I need.

Bonus Tip: You can change your 
settings to force Outlook to save emails to 
the same folder it was sent from (so long 
as the folder is not the Inbox Folder). So, 
if you are responding to an email that is 
in a client folder, your response will not 
be saved to Sent Items but will be saved 
directly in the client folder. To change this 
setting, click on File>Options>Mail. Then, 
in the Save Messages section, check the 

Top 5 Email Management/Organization 
Tips for Outlook
BY KIMBERLY A. HILTON
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second box which reads “When replying to 
a message that is not in the Inbox, save the 
reply in the same folder.”

4) Regularly Back Up Your Data 
with .PST Files

Email backups are essential, particularly 
if you rely heavily on Outlook for both 
personal and professional communication. 
To ensure that your email data is always 
safe, it’s wise to create regular backups 
using a Personal Storage Table (.PST) file.

To create a .PST backup:
•	 Open Outlook and go to the File tab.
•	 Select Open & Export, then click 

Import/Export.
•	 Choose Export to a file and select 

Outlook Data File (.pst).
•	 Choose the folders you want to back 

up (e.g., Inbox, Sent Items, Client 
X) and save the .PST file to a secure 
location.

Creating .PST backups ensures that 
even if you lose access to your Outlook 
data, you’ll have a secure copy to restore 

from. I like to use this to backup the email 
for my client files. This allows me to save 
the email communications when a matter 
is closed without making my Outlook box 
any bigger than it has to be. Remember, a 
large Outlook file size will likely slow down 
your computer and will lead to Outlook 
“hanging” or not responding when you 
need it to work. If you need to access the 
email in the future, you can open the .pst 
file in Outlook and see the messages just as 
they were when you backed them up.

5) Flag Emails for Follow-Up
One of the most useful features in 

Outlook for staying on top of your tasks 
is the ability to flag emails for follow-up. 
Flagging an email marks it as important, 
so you don’t forget to take action on it. You 
can set deadlines or reminders, making it 
easy to manage emails that require further 
attention.

To flag an email:
•	 Right-click on the email you want to 

flag.

•	 Select Follow Up, then choose from 
options like Today, Tomorrow, This 
Week, or Custom to set a specific 
reminder date.

You can also use the Task pane to view 
all flagged emails and tasks in one place, 
ensuring nothing slips through the cracks. 
You can also view all reminders for email 
you have flagged using the To Do App.

By utilizing these five email 
management tips—Quick Parts, Quick 
Steps, organized, folders, .PST backups, 
and flagging for follow-up—you can 
take control of your Outlook inbox and 
improve your productivity. Whether you’re 
managing personal or professional emails, 
these features help reduce time spent on 
repetitive tasks, keep you organized, and 
ensure you never miss important messages 
or deadlines. With a little setup, Outlook 
can become a powerful tool for managing 
your email workflow efficiently. n
This article was originally published in Legal 
Technology (February 2025, Vol. 32, No. 3), the 
newsletter of ISBA’s Standing Committee on 
Legal Technology.

Illinois State Bar Association

High School Mock  
Trial Invitational

March 14-15
Lincoln Land Community College

Springfield, IL

The 2026 ISBA High School Mock Trial Invitational will be 
held on Saturday, March 14, and Sunday, March 15, 2026, at 

Lincoln Land Community College in Springfield.

Judges, lawyers, paralegals, law students, and other legal 
professionals are needed to act as presiding judges, jurors/
evaluators, and bailiffs for each trial. You do not have to be a 
litigator to volunteer! Deadline to sign up is February 2, 2026.

isba.org/teachers/mocktrial
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GENERATIVE AI (GenAI) IS REVOLUTIONIZING industries 
worldwide, including the legal profession. While this technology 
presents immense opportunities, it also comes with unique 
challenges that lawyers must understand and navigate. This guide 
highlights the red flags lawyers should watch for when using 
GenAI and offers actionable best practices to ensure its ethical and 
effective use in legal practice.

Why Generative AI matters for lawyers
GenAI tools like ChatGPT, Claude, and Perplexity have the 

potential to transform how lawyers work. From drafting legal 
documents to summarizing transcripts and analyzing case law, 
these tools offer significant time savings and increased efficiency. 
However, lawyers must balance the convenience of AI with the 
profession’s ethical obligations of accuracy and due diligence.

Common red flags in using Generative AI
1. Document Formatting Errors
AI often struggles with certain file formats, especially scanned 

PDFs that lack proper OCR (Optical Character Recognition). If 
you upload a poorly formatted document, AI may fabricate or 
misinterpret its contents. Uploading text-based formats like Word 
documents or plain text can help ensure accuracy.

2. Math and Numerical Discrepancies
Despite its advanced capabilities, GenAI is prone to calculation 

errors. Lawyers who rely on AI for fee calculations or analyzing 
numerical data must double-check its output. Interestingly, while 
AI is unreliable at performing calculations, it excels at identifying 
inconsistencies in numerical data, such as discrepancies in tables.

3. Inaccurate Visual Representations
When asked to generate diagrams or visual aids, GenAI often 

misrepresents scale or dimensions. For example, AI-generated 
images of transmission lines might depict incorrect distances 
or numbers of affected properties. While useful for preliminary 
brainstorming, lawyers should not rely on AI-generated visuals for 
court presentations or legal arguments.

4. Imprecise Contract Analysis
AI tools frequently oversimplify or misinterpret complex 

contract terms. For instance, an indemnification clause might be 
summarized incorrectly, omitting critical details. Moreover, AI 
can conflate terms, turning “A or B” obligations into “A and B.” 
Lawyers must manually verify all AI-generated summaries to avoid 
malpractice risks.

5. Fabricated Legal Citations
Perhaps the most infamous red flag is AI’s tendency to 

“hallucinate” legal citations. While the output may look realistic, 

the referenced cases or articles may not exist. Even when AI 
provides seemingly legitimate links, lawyers must click through 
and verify the sources to ensure authenticity.

6. Misunderstandings and Misreadings
AI tools occasionally misinterpret even straightforward 

documents, leading to significant errors. For example, when 
tasked with summarizing a Supreme Court transcript, ChatGPT 
generated inaccurate summaries of the arguments. This 
demonstrates the importance of cross-checking AI outputs with 
the original documents.

7. Inherent Biases
Generative AI models often reflect societal biases. For instance, 

a generic request for an image of a lawyer might yield a white 
man in a suit unless explicitly instructed otherwise. Similarly, 
gendered assumptions can influence AI-generated content, such as 
emphasizing work-life balance for women over professional goals.

Bonus Red Flag: Plagiarism Risks
AI-generated content can inadvertently replicate existing 

materials, raising potential copyright concerns. Before using 
AI-generated marketing or blog content, lawyers should run it 
through a plagiarism checker to avoid legal disputes.

Best practices for using GenAI in legal practice
To mitigate risks and maximize benefits, lawyers should adopt 

the following strategies:
1. Understand the Limitations
Awareness of GenAI’s potential pitfalls is the first step to 

Unlocking the Potential of Generative AI 
for Lawyers: Red Flags and Best Practices
BY CAROLYN ELEFANT 
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responsible use. Recognize where the technology excels (e.g., 
spotting data inconsistencies) and where it struggles (e.g., legal 
reasoning or numerical calculations).

2. Verify All Outputs
Whether it’s a contract review, case citation, or legal brief, 

always double-check the AI-generated content. Treat the AI as a 
junior associate whose work requires supervision.

3. Use Paid Models
Paid versions of tools like ChatGPT and Claude offer advanced 

capabilities, including higher character limits and improved 
accuracy. Investing in these versions ensures better performance.

4. Cross-Check Using Multiple Platforms
Leverage different GenAI tools to validate outputs. For 

example, use ChatGPT for drafting and Perplexity for verifying 
citations. This redundancy reduces the risk of relying on incorrect 
information.

5. Provide Specific Prompts
Detailed and precise instructions improve AI output. For 

instance, if generating marketing images, specify diverse 
representations to counteract biases.

6. Incorporate AI Training
Correct errors by providing feedback to the AI platform. This 

not only improves your interaction but contributes to refining the 
technology for broader use.

7. Run Plagiarism Checks
Before publishing AI-generated content, ensure originality 

by using plagiarism detection tools. Even better, personalize the 
content to reflect your unique voice and insights.

Embracing AI responsibly
Generative AI offers unparalleled opportunities for innovation 

in legal practice, but it is not a silver bullet. By understanding its 
limitations and implementing safeguards, lawyers can harness 
its potential while maintaining the profession’s high standards of 
accuracy and integrity.

As technology evolves, staying informed and adaptable will be 
key to leveraging AI responsibly. If you’re ready to dive deeper into 
GenAI for lawyers, consider joining specialized training programs 
to refine your skills and stay ahead in this rapidly changing 
landscape. n

This article was originally published on January 21, 2025, on the MyShingle.
com blog of Law Offices of Carolyn Elefant, and is republished here with 
permission.

CALLING ALL 
LEGAL BLOGGERS!
Are you an ISBA member with a legal blog? The ISBA 
wants to help elevate your content and make it available 
to a wider audience through Illinois Lawyer Now.

Be a part of one of the FIRST state bar-sponsored legal 
blog aggregation sites!

Joining is easy and FREE, simply fill out the quick form at IllinoisLawyerNow.com/join

https://myshingle.com/2025/01/articles/artificial-intelligence/unlocking-the-potential-of-generative-ai-for-lawyers-red-flags-and-best-practices/
https://myshingle.com/2025/01/articles/artificial-intelligence/unlocking-the-potential-of-generative-ai-for-lawyers-red-flags-and-best-practices/
http://www.lawofficesofcarolynelefant.com/
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